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Conventions used in this manual 

The following conventions are used in this manual: 

Menu path: Example: Tap Star t > All Programs > Games > Solitaire. This means tap the 
Start menu button, then the All Programs button, then select Games from the menu that is 
displayed, and Solitaire from the Games menu. 

Keyboard: Example: Hold down the <Ctr l>+<Alt>+<Del> keys simultaneously. This means 
press these keyboard keys, all at the same time. 

 

Symbols are used to represent important things you need to know: 

 

Warning about cost. Doing this action could cost you money! 

 

Severe warning! Be extra careful! You could seriously damage the machine. 

 

Note, hint or tip. Information that will help you. 

 

 



Notebook Training Manual for Acer TravelMate 530  Department of Education and Training 

Version 1.0 2003 Page 5 of 36 

Program objectives 

The Notebook for Teachers Program is an integral component of the Education to Community 
(e2c) initiative, supporting learning technologies in the K-12 government education 
community in WA. 

It is designed to support schools and teachers in achieving their mutual professional goals. The 
portability of notebook computers allows for a wide range of educational opportunities and 
strategies to be explored, with the ultimate aim of improving outcomes for students. 

Participation in the program is voluntary and should only be undertaken after careful 
consideration of how the introduction of this technology can be integrated into the individual 
school's plan. 

The objectives of this training are to: 

�  Provide an introduction to the notebook, the operating system, and the applications. 
�  Help you to become more familiar with basic operations of the notebook. 
�  Assist you with setting up the notebook for internet access from home and your school. 

 

 

More details about e2c can be found on the internet at: http://www.e2c.wa.edu.au 
where you will also find a link to the Notebooks for Teachers web site. 

A number of DOET (Department of Education and Training) policies directly relate to 
the safe-keeping of work-related information and appropriate use of corporate 
applications such as e-mail and internet access. More details on these and other DOET 
policies is available on the Regulatory Framework CD. An updated copy of this CD is 
sent to all schools each term. 

 

 

 



Notebook Training Manual for Acer TravelMate 530  Department of Education and Training 

Version 1.0 2003 Page 6 of 36 

Occupational health and safety 

The following is a summary of Occupational Health and Safety issues, detailed in Appendix D 
on page 32. 

 

The Department’s Safety Consultant has provided the following advice: 

Discomfort as a result of strain to the shoulders, neck, arms and eyes is common among users 
of notebooks. This can, in some instances, lead to occupation overuse injuries, also known as 
repetitive strain injuries (RSI). The likelihood of prolonged pain and possible injury is 
increased when the notebook is used for more than 2 hours in any one session. 

Strain often occurs due to the inability to set up the notebook in the correct ergonomic position 
(as the keyboard and screen cannot be separated), and through use in environments that result 
in poor posture (for example, on the couch) or cause glare. 

Where possible, personal computers should be used in preference to notebooks as they can be 
set up ergonomically to minimise the risk of strain or injury. 

Consideration should also be given to any staff member who has an existing strain or injury to 
the neck or shoulders, as carrying a notebook can further aggravate the condition. 

The risk of strain or injury through notebook use can be reduced by implementing some 
simple strategies such as: 

�  Taking regular rest breaks (at least every 20 minutes; more often if the setup is not 
ideal) to allow muscles and vision to recuperate. 

�  Not using the notebook for more than 2 hours in any session. 
�  Working in an environment free from glare. 
�  Using the notebook on a desk (rather than the lap). 
�  Angling the screen to minimise the need to bend the neck. 
�  Using an external mouse, keyboard, and monitor where possible. 
�  Using a chair that maintains good posture. 
�  Reducing the need to carry the notebook (where practicable). 
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What you will receive 

The Department of Education and Training will provide all nominated teachers with: 

�  An Acer TravelMate 530 Notebook computer. 
�  A familiarisation training course on delivery of your notebook. 
�  Warranty support and a Customer Service Centre for dealing with product faults and 

difficulties, including on-site warranty or transport of the notebook to and from the 
repairer. 

Software 

The following software applications will be pre-loaded onto your notebook: 

�  Microsoft Windows XP Professional 
�  Microsoft Office XP, incorporating: 

�  Microsoft Word 2002 
�  Microsoft Excel 2002 
�  Microsoft PowerPoint 2002 
�  Microsoft Outlook 2002 
�  Microsoft FrontPage 2002 
�  Microsoft Publisher 2002 

�  Microsoft Encarta Reference Library 2003 
�  Microsoft Windows Media Player 9.0 
�  Microsoft Movie Maker 2 
�  Microsoft Windows Media Bonus Pack 
�  Microsoft TV Photo Viewer 
�  Microsoft Visio Viewer 2002 
�  Microsoft Interactive Training, incorporating: 

�  Office XP Pro Step by Step Interactive  
�  Windows XP Professional Step by Step Interactive  

�  Adobe Acrobat Reader 5.0 
�  QuickTime Player 6 
�  Macromedia Shockwave 8.5 
�  McAfee VirusScan 4.5 

Hardware 

Your notebook will have the following hardware configuration: 

�  Intel Pentium 4, 2.0 GHz Processor 
�  14.1”  TFT (thin film transistor) screen (measured diagonally) 
�  256 Megabytes of RAM (16MB allocated to shared video memory) 
�  20 Gigabyte hard disk drive 
�  Internal 10/100BaseT Ethernet for network connections at school 
�  Internal 56K modem for remote connection via telephone line 
�  CD ROM Drive 
�  1.44MB floppy disk drive 
�  Internal stereo speakers 
�  Touchpad, with left and right mouse buttons and scrolling button 
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Accessories 

In addition to your Acer TravelMate Notebook, the following accessories are supplied. Please 
check that they are all there.  

�  Acer carry case (black) 
�  AC power supply, with cable 
�  Phone (RJ11) cable (grey) 
�  Passport: International Travelers Warranty 
�  Modem User’s Guide 
�  TravelMate 530 User’ s Guide 
�  Two Recovery CDs (with instructions) 
�  One System CD 

 

 

It is a good idea to keep your box should you need to transport your notebook back to 
Acer for repair. It is particularly important that you have access to a box if you are in a 
country area and your notebook needs to be safely packed for return to Acer.  

 

Notebook tour 

Front 

The floppy disk drive is found at the front of 
the notebook toward the left. 

When you insert a floppy disk into the drive, a 
small disk eject button will pop out. Press this 
button in to eject the disk when you have 
finished with it. 

 

DO NOT pack away your 
notebook with a floppy disk 
still inserted – you could cause 
damage to the disk eject 
button. 
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Left side 

 

 

CD drive warning 

When inserting a CD into the CD drive, make sure it is firmly seated on the central 
black spindle in the CD tray. If it is just balanced on the top of the spindle, it will jam. 

The CD player in this notebook is controlled by software, so it cannot be used when 
the notebook is turned off. Likewise, the CD ROM drive will not open when it is 
turned off. 

Underneath 

On the bottom of your notebook are a number of identification stickers. The 8-digit Australian 
Serial Number (AUST Serial No.) is the one that is most important to you.  

 

This serial number is linked to YOU – you cannot swap notebooks with other 
teachers. 

You will need to quote the Australian Serial Number if you require service or 
assistance from the Customer Service Centre. 
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Back 

 

 

1 Ventilation slots A ventilator is situated at the rear right hand side and back. 
Your notebook is fitted with a fan that is controlled by a 
thermostat. The fan will turn itself off when the notebook is 
cool enough. 

2 Security slot This small oval slot is for optional lockable security devices, 
and is Kensington-compatible. With such security devices 
you can lock your notebook to a bench or fixed object. 

3 Power socket (yellow) Takes the small round plug from the Power Adaptor, and 
provides mains power to the notebook when connected. 

4 External monitor port 
(blue) 

Accepts any type of external display device such as a normal 
computer monitor and computer projection devices.  

5 Docking Station port Used if you purchased the optional docking station. A 
docking station accepts a monitor, keyboard, and external 
mouse and, with one action, connects or disconnects them 
from your notebook. Also known as a Port Replicator. 

6 Parallel port (pink) Printer connection for older printers. 

7 Network port Accepts a network cable for connecting to your school 
network – this has a plug just a little wider than the phone 
plug. The network card is built in to this notebook model. 
Your notebook's network information must be configured so 
that it can be recognised by the school network (see 
Connecting your Notebook to the school network on page 
20). 

8 S Video port Used to connect your notebook to any television with S 
video sockets. 

9 USB ports This model has three USB (Universal Serial Bus) ports. 
Accepts USB devices. These can transfer data between the 
device and the notebook (or vice versa) quicker than other 
ports. Examples of USB devices are printers, digital still and 
video cameras, scanners, external drives, mouse. Windows 
XP will automatically recognise a device plugged into a USB 
port and the drivers may already be installed. 

 

1           2        3        4                   5                     6                  7            8        9 
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Right side 

 

 

 

10 Microphone / audio 
input (pink) 

 

Starting from the front is the Microphone / audio input, for 
audio in (recording a sound from an audio tape or CD player 
into your notebook), and for connecting an external 
microphone. (An internal microphone is located above the 
keyboard.) 

11 Headphone / speaker 
port (green) 

Next is audio out for plugging in external speakers or 
headphones. 

12 PCMCIA Expansion 
slots  

Other devices can be added by installing PC Cards and 
compatible devices into these slots (for example, wireless 
LAN cards).  

13 Modem port This is the modem port where the black modem cable that 
came with your notebook is plugged in. Use this to connect 
the inbuilt modem in the notebook to the telephone network 
for internet use (generally at home, since most schools have 
internet access through their school networks) and for using 
the fax facilities of the modem to send or receive faxes. 

14 Firewire port This is a high speed port to allow you to connect devices 
such as digital video cameras, external hard drives, or 
external CD burners. 

15 Infrared port The infrared port which allows the fast transfer of data 
between your notebook and similar computers (including 
PDAs) without using cables. 

16 Ventilation slots A ventilator is situated at the rear right hand side and back. 
Your notebook is fitted with a fan that is controlled by a 
thermostat. The fan will turn itself off when the notebook is 
cool enough. 

 
 

  10    11                      12                      13       14         15          16                  
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Using your notebook 

Open it 

Find the slider button at the centre front of the lid, gently slide it to the right, then lift the lid 
(screen) until it is open. 

Turn it on 

The power button is above the top left hand side 
of the keyboard. Gently press and hold the button 
for a second or two until the notebook starts. 

 
 

 

The power button is usually used only as an On switch – your notebook automatically 
turns itself off as part of the shutdown procedure. 

If your notebook stops responding to keyboard or mouse input, you may be forced to turn 
it off. To do this, hold the power button down for at least 5 seconds to turn it off. 

 

Touchpad 

Before you do anything, you need to know about 
your notebook's 'touchpad' area. 

The touchpad is your 'mouse'. Moving your finger 
around it will move the pointer (or cursor) on the 
screen. When using the touchpad to move the 
pointer around the screen, try to keep your finger 
on the touchpad. Lifting your finger will stop the 
pointer moving.  

The buttons below the touchpad are your left and right mouse buttons. As you get more 
experienced, you can operate these buttons with your thumb as you use your finger to move 
the pointer around the screen. The right mouse button has the usual function of opening a 
menu relevant to the place where the pointer is pointing. 

You can 'tap' the touchpad instead of clicking the mouse buttons: 

�  A single tap = a single left mouse click 
�  A double tap = a double left mouse click 
�  A double tap + drag = a normal drag holding the left mouse button down. This 

may take some practice. Double tap but hold your finger down on the second tap 
and move it across the screen for the 'drag'. 

This notebook model also has a scrolling 'button' which scrolls when you press down on either 
end, similar to the scrolling wheel on a mouse. The lower button scrolls down; the upper 
button scrolls up. 

You can change the speed of the cursor movement and the size of the cursor (see Appendix A 
on page 29 for details). To practice using the touchpad, play some games of Solitaire – now 
you’ve got an excuse to do this! 
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Where do I start? 

 

Your notebook is installed with Windows XP – a very different version of Windows. 
Please take your time to explore the new operating system. 

Log in 

1. After turning on your notebook, the 
Welcome to Windows screen is 
displayed, where you are prompted to 
log in.  

2. Press <Ctr l>+<Alt>+<Del> to log in. 
The Log On to Windows screen is 
displayed, where you are prompted for 
your user name and password. 

3. Check that your User name is correct 
(see About user names, below). 

4. Type your password. 
5. Tap OK. 
6. The desktop screen is displayed. 

 

 

 

A b o u t  u s er  n am es  

The first time you turn on your notebook, you will be prompted for your user name and 
password. Your user name is supplied by the Department. If you use a computer at school and 
have been granted access to the school’s admin network then you will already have a user 
name and password. You can use these as soon as the notebook is linked in to the school 
network. If you do not have a user name and password, either contact your school's system 
administrator or phone the Customer Service Centre on 9264 5555 (metropolitan) or 
1800 012 828 (country). 

A b o u t  p as s w o r d s  

If you are using your user name and password for the first time, you will be prompted to 
change your password to something that only you know. Type the password in twice as 
requested. The next time you log in, you will only type your password once. 

 

Your password should be something you will remember, yet be obscure enough that 
no one will guess it.  

You should not give this password to anyone but it is very important that you 
remember it as you cannot log in without it. If you forget your password, you should 
contact the Customer Service Centre on 9264 5555 (metropolitan) or 1800 012 828 
(country). 
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The desktop 

 

1. When you have successfully supplied both your user name and password, the desktop 
window (above) is displayed. At the bottom left of the screen is the Start button 

. 
2. Using the touchpad, move the pointer over the Start button, and tap once. The Start menu 

is displayed. 

The Start menu 

This is your starting point for everything, so let’s 
take a closer look at this menu.  

Your user name is displayed at the top of this 
window. Below this there are two columns.  

At the top of the left column is internet Explorer, 
followed by a list of you most recently used 
applications (software programs) – this list will 
change according to which applications you have 
used recently or most often.  

The right column lists common storage locations 
for your files and utilities and features that will 
help you. 

Under the left hand list is the All Programs 
button. Tap on it to open a menu list of all the 
applications on your notebook. 

 

My Documents Where you can store your documents. 

My Recent 
Documents 

The files and documents you have been working on most recently. 

My Pictures Where you can store your pictures. 

My Music Where you can store your music. 

My Computer  Displays the full contents of your hard drive, CDs, floppy disks or other 
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removable media. 

My Network 
Places 

Displays servers and other shared workspaces when you are connected 
to the school’s network. 

Control Panel Where you can adjust your notebook's settings. 

Connect To Displays places you can connect to, including the Notebooks for 
Teacher Dialler.  

Pr inters and 
Faxes 

Where you can add printers. To add a network printer, contact your 
school's system administrator or the Customer Service Centre. 

Help and 
Support 

If you get stuck, always try the online Help and Support first. 

 

 

Don’ t be scared to use this. Windows XP has 
comprehensive help functions, including small 'walk-
through' procedures that help you complete an unfamiliar 
task. 

Search If you can't find a file or have forgotten where you stored it, use Search 
to find it. 

Run This is an alternative method for starting programs, but requires quite a 
bit of technical knowledge. It is much easier to use the All Programs 
button. 

 

Quick Launch bar 

At the bottom left of the screen, you will see your Star t menu button. Immediately to the right 
of  is the Quick Launch bar, and at the far right of the screen is the System Tray. We 
have already discussed the Star t menu button, so let's look at the Quick Launch bar. 

 

There are six icons in the Quick Launch Bar. These are: Internet Explorer, Show Desktop, 
Word, Excel, Outlook, and Publisher. A single tap on any of these will open the application. 

As you open other applications, they will be displayed between the Quick Launch bar and the 
System Tray. To minimise an application's window, tap the application’s button to the right of 
the Quick Launch bar at the bottom of the screen; tap it again to maximise it. 

In the example below the following are all open: Explorer, a Word document, an Excel 
workbook, a Publisher document and a web page. Practice opening multiple applications and 
maximising and minimising them. 

 

In Windows XP, if you have more than one file open in an application it will put the number 
of files open in that application next to the application’s title. In the example below there are 
four windows open in Word, four in Excel, two in Publisher, and two web pages (internet 
Explorer). To access any of these files, tap on the application and it will open a small menu 
with the names of all the open files. Tap on the file’s name to display it. 
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Qu i c k  L au n c h  b u t t o n s  

There are three oval buttons on the notebook, just 
below the screen that can be programmed to 
launch your favourite applications at the press of 
a button. These are P1, P2, and P3. 

To set the functions of these buttons, either press 
one of these keys (if no application is currently 
assigned to it), or tap Start > All Programs > 
Launch Manager > Launch Manager. 

 

 

 

This very basic introduction has got you up and running with your new notebook. We'll soon 
be getting you connected to the internet and checking your e-mails! In the meantime, here are 
some more useful things to know about your notebook and the operating system… 
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Managing your documents 

When you are working in a new document you will be asked to save the file before you close 
it. It is important to keep all your files in the same place so they are easy to back up. We 
recommend that they be stored in My Documents and so we have set up your system to 
automatically save your files to My Documents. 

1. In the Quick Launch bar at the bottom of the screen, tap  (Microsoft Word) once. 
2. Type some text in this new document. After you have done some work on your 

document, you should save it. 
3. Tap File > Save. The Save As window is displayed. 

 

4. Check that the Save in location at the top of this window is My Documents. If it isn't, 
tap the large My Documents icon on the left of the window. 

5. Type a name for this new file in the File name field at the bottom of this window. 
6. Tap the Save button located in the bottom right of the window.  

All documents you create should be saved to your My Documents folder. This saves you time 
as you don’ t have to look for your work – it will all be in My Documents.  

You can organise your My Documents folder however you like – you can have sub-folders 
within folders and as many as you want. This makes it easy to back up your work – you just 
drag the whole My Documents folder to a server location, a disk, or any other type of backup 
device. 

You can also display your My Documents folder however you like (examples below). Just 
make sure it is easy for you to follow and navigate. It doesn't matter what the teacher who 
keeps looking over your shoulder in the staff room thinks – this is your preference, it is your 
work, and it is you who needs to retrieve it – so work in a way that suits you. 
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Power management 

Your notebook can be set up to run off batteries or mains power. When you are near a power 
point, you can plug it in to run off mains but when you are away, you will run the notebook 
from the battery. Here are some ways to get the most life out of your battery when you are 
away from power. 

1. Tap Star t > Control Panel. 
2. Double-tap on Power Options. 
3. Check the settings under the Power Schemes 

tab. These should generally be set as shown 
in the picture to obtain maximum life from 
your fully charged battery. You may increase 
any of these settings, but if you do your fully 
charged battery may not last as long as it 
might otherwise do. 

4. Tap on the Advanced tab and check these 
settings. 

5. Tap on the Alarms tab and check these 
settings. You can have a visual signal of a 
low and critically low battery or you can set 
a sound, or you can set both. 

6. Tap on the Power Meter  tab and check the 
settings. These give an indication of the 
battery power remaining if you are working 
without the mains power plugged in to your 
notebook. (You can also see this information 
by double clicking on the battery icon in the 
System Tray). 

7. When you have finished, tap OK. 
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Other settings 

Displays/Monitors 

1. Tap Start > Control Panel. 
2. Double-tap on Display. The Display Properties 

window is displayed. 
3. Tap the Settings tab. If you are using an external 

device (for example, a computer pojection unit or 
an external monitor) you can adjust the screen 
resolution and colour quality to suit that device. 

4. Take a look at the other tabs for further settings 
you can adjust to suit how you work. 

5. When you have finished, tap OK. 
 

 

System Tray 

In the bottom right corner of the desktop is the System Tray. This 
contains icons for a number of functions. 

Double-tap on the time – the clock in your notebook has already 
been set but if it's not correct you can change it.  

Check the other icons to see what they do. 

 

Help 

To get help with Windows XP at any time, tap Star t > Help and Support. 
 

Other software 

Look through the Start > All Programs menus to see what software applications have been 
pre-loaded onto your notebook for which there is no Quick Launch button.  
 

Turning off your notebook 

1. Tap Start. 
2. Tap Shut Down. The Shut Down 

Windows screen is displayed. 
3. Select the Shut Down option if it is 

not already selected. 
4. Tap OK. Your notebook will go 

through a short shut down process 
and turn off automatically. 
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Connecting your notebook to the school network 

 

It is important that you successfully connect your notebook to the school’s admin 
network in order to complete the initial set-up of your notebook. Once you have 
completed the set-up you will have access to a range of vital services and functions 
including: 

�  Automatic updates of applications on your notebook when they become 
available. 

�  Regular antivirus updates. 
 

Follow these steps to connect your notebook to the network: 
1. Connect the notebook to an admin network outlet at the school – the outlet and the cable 

will be supplied by the school. Do not use the black modem cable that came with your 
notebook as it is unsuitable for this purpose. 

2. Ask your school's system administrator to login and 'join' your notebook to the Admin 
domain. This will give you access to the school’s network and servers and will also 
allow you to access the internet and e-mail while at school. If your school's system 
administrator is not available, you can phone the Customer Service Centre at the 
Department and ask for assistance: 9264 5555 (metropolitan) or 1800 012 828 (country). 

3. Outlook must have its settings changed to match the personal information stored in 
Control Panel > Mail. Ask your school's system administrator to set this up for you. 

4. Your school’ s system administrator will also set up the internet Explorer proxy settings 
so that you can use the internet at school. 
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Backing up your files 

 

Keeping separate copies of your own files is absolutely vital when you use a 
notebook. If your notebook is stolen or if your hard drive crashes, you lose all the hard 
work that you have put into the files you have worked on, unless you have kept a 
backup copy of your files somewhere else. If you save on floppy disks, do not keep 
the disks in your notebook bag! 

 

What are some backup options? 

Backup to 
the school 
network 

When you are at school and attached to the network, you will have a personal 
folder on the server. All of your documents should be stored in your My 
Documents folder – from time to time, even daily, you should copy the 
contents of your My Documents folder to the server. 

Use 
Microsoft 
Backup 

This is a program found in Start > All Programs > Accessories > System 
Tools > Backup. Microsoft Backup puts a compressed copy of your My 
Documents files onto floppy disks. You need new or reformatted floppy disks 
before you start. Keep in mind that floppy disks do not hold a lot of files. 

The Restore function takes the backed up data files and returns them to the 
nominated directory on the notebook. This is better than simply saving 
everything twice – once on your hard drive and once on floppies, since it 
compresses the files (taking up less space) and you only need to number the 
floppies (a date is a good idea too!) rather than label the disks with a list of its 
contents.  

CD Writer 
or Zip 
Drive  

If you have a CD Writer or Zip Drive, you can use these to back up your files. 
A Zip disk (about $25.00) will store up to 250MB and a CDR up to 700MB. 

A Zip Drive operates very much like a floppy drive and will appear in your 
My Computer  window. To copy files you simply need to drag the files to 
this drive icon.  

A CD stores more information but takes longer to write and it is not as simple 
as dragging files to an icon. CDRs are, however, much cheaper at around 
$1.00 ea or $2.50 for a CD which can be overwritten and re-recorded.  
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Virus Protection 

Antivirus software is installed on your notebook. When you are connected to the Admin 
domain on the school's network, one of the first software updates you will receive will be for 
your antivirus software.  

Ways to avoid virus contamination  

Be aware that sharing any file exposes the notebook to possible virus contamination. Scan all 
files to be copied or opened from the notebook before loading. This includes files on floppy 
disks, zip disks, the school’s network, or files copied from the internet. 

When downloading files from the internet, or viewing attachments via e-mail, be aware that 
the risk of virus contamination is high. If a virus scan is performed before a file is opened, the 
risk of contaminating the notebook is minimised.  
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Looking after your notebook 

Safety issues 

Refer to Important Safety Instructions in the Notices section (Appendix B) of the TravelMate 
530 Series User’s Guide for important safety information. 

Care and cleaning of your notebook 

Refer to Basic care and tips for using your computer in the First Things First section of the 
TravelMate 530 Series User’s Guide for a full guide to the care and maintenance of your 
notebook, AC Adaptor, and battery pack. The information that follows is only a summary. 

To clean the notebook and the screen, use a slightly damp clean cloth and finish with a soft 
dry cloth. Do not use ANY cleaning agents, detergents or solvents 

Batteries 

The battery that ships with your Acer TravelMate notebook is a Lithium Ion (L-Ion) battery. It 
is not prone to the same 'memory' problems encountered by those using Nickel Metal Hydride 
(NiMH) batteries. To ensure the life of your battery remains at its maximum: 

�  It is good practice to run your battery down completely once every month or so. 
�  Do not 'top up' your battery often – it is better to be recharged from flat. 
�  Do not take your battery off charge until it is completely charged. 

Continuous misuse of the battery may result in shorter battery life. 

Actual battery life may vary, depending on usage and configuration. It also depends on what 
kinds of activities you do on the notebook. If you often access the attached hardware (for 
example, CD ROM drive, modem, and LAN) the battery life may be considerably shortened. 
You can set up power management options to conserve your battery power (see Power 
Management on page 18 for details). 

AC power supply care 

Incorrect use and storage of AC power supply units can cause damage, particularly to the 
cable. To avoid damage to your AC power supply it is important that you follow a few basic 
steps. 

Us i n g  t h e  A C p o w er  s u p p l y  

Make sure that the cable is not twisted or bent sharply at any point. Avoid having to run it 
around furniture in such a way as to risk damage. 

 

To avoid damage to cables never crease or apply pressure to any folds. All folds 
should be naturally formed. 

S t o r i n g  t h e  A C Po w er  Su p p l y  

1. Switch off the mains power.  
2. Disconnect the power supply from the power outlet and notebook. 
3. Disconnect the power cord from the AC adaptor. 
4. Take the AC power supply, leave approximately 18cm of cable free from the 

transformer, then roll the remaining length of cable into approximately 10cm lengths and 
secure it with a tie. 
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Make sure that the cable is not bent sharply, 
particularly where it exits from the 
transformer as this will cause the cable to 
wear over time. 

 

 

LCD screen care 

When it is necessary to clean the LCD, use a soft, lint-free cloth, or use the contents of any 
commercially available computer LCD cleaning kit. 

 

Caution:  

�  Never use alcohol, petroleum-based solvents, or harsh detergents to clean 
your notebook.  

�  Never spray or apply any liquids directly on the notebook case, keyboard, or 
screen.  

�  Do not use paper towels to clean the screen – paper can scratch it. 
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Service, support and warranty information 

Warranty Period - 36 month Limited Warranty for DOET  

This 36 month limited warranty commences from the date the notebook is shipped to you and 
covers: 

�  Cost of labour and replacement parts for 36 months including floppy disk drive, CD 
ROM, LCD Screen and battery pack. 

�  Cost of freight to pick up and deliver the notebook for repairs to and from the 
authorised Acer Notebook Repair centres. 

�  On-site repair in the metropolitan area. 

Warranty service is provided by Acer Authorised (Notebook) Repair Centres (subject to the 
conditions set out below). The warranty only extends to hardware parts purchased from Acer. 

Warranty conditions for Acer hardware 

Acer warrants that the product you have purchased is free from manufacturing defects in 
materials and workmanship when dispatched from our warehouse. The warranty period 
commences from the date the notebook is shipped to you. Due to the unique nature of the 
battery component of notebooks, warranty replacement of a battery shall not be required 
unless the duration of its battery life is less than 80% of the life specified in the notebook 
documentation. 

M et r o p o l i t an  –  O n - S i t e  War r an t y  

If your notebook is located within the metropolitan area it shall normally be serviced by a 
technician on site at your school within twenty-four hours of the support call being lodged by 
the Department’s Customer Service Centre, taking into account school business hours. In the 
event that a replacement component needs to be sourced from interstate, on site attendance 
may be extended a further twenty four hours. 

An appointment must be made in consultation with the user or a nominated representative to 
ensure that an authorised person is available at the school site to provide access to the faulty 
notebook. Generally this will be during school business hours unless by special arrangement. 

If your notebook cannot be repaired on site then the technician shall collect the unit and 
transport it to the repair centre to effect repairs. Your notebook will be repaired and returned to 
you within forty-eight hours of collection. Weekends and public holidays are not included in 
the calculation above. 

Co u n t r y  -  Re t u r n  t o  B as e  s e r v i c e  

If your notebook requires Return to Base Service (RTB), it shall be collected from your school 
within twenty four hours of the support call being lodged by the Department’s Customer 
Service Centre, taking into account school business hours. Collections and returns should be 
made in consultation with you or a nominated representative to ensure than an authorised 
person is available at the school site to provide or receive the notebook. 

Your notebook will be repaired and returned to you within seventy-two hours of collection. 

 

Whether you are in the metro area or the country, you will need to ensure the notebook 
is left with the Registrar at the school if you are unable to be present when the service 
technician or courier arrives.  

When a notebook is collected from your residence, you must be present for the courier 
at the agreed collection and delivery times, otherwise you will be responsible for the 
courier cost of an unsuccessful pickup or delivery. 
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Sc h o o l  h o l i d ay s  

Warranty processes are in place for school holidays. You will need to contact the Customer 
Service Centre and advise which of the following options is most convenient: 

Metropolitan Country 

�  Drop your notebook to the District 
Office for on-site service. 

�  Arrange for your notebook to be 
collected from your home to be 
serviced at an Acer Authorised Repair 
Centre. 

�  Take the notebook directly to an Acer 
Authorised Repair Centre. 

�  Drop your notebook to the District 
Office to be collected and to be 
serviced at an Acer Authorised Repair 
Centre. 

�  Arrange for your notebook to be 
collected from your home to be 
collected and serviced at an Acer 
Authorised Repair Centre. 

I n t e r s t a t e  an d  i n t e r n a t i o n a l  w ar r an t i es  

If you are travelling interstate, your notebook is covered by Acer’s Australia-wide warranty 
service. Please contact the nearest Acer Office.  

If you are travelling internationally, your notebook will be covered by Acer’s international 
warranty service. Please obtain a letter of warranty from Acer’s Perth office. 

Di r ec t  t o  A c er  

You can take your notebook to an Acer Authorised Service Centre directly if this is more 
convenient. Turnaround on such work is two hours. 

The Acer Authorised Service Centre in Western Australia is at: 

Acer Computer Australia 
Level 3, 30 Hasler Road 
Herdsman Business Park 
Osborne Park WA 6017 

Service 

If you need hardware support for your Acer notebook:  

1. First call the Department’s Customer Service Centre on 9264 5555 (metropolitan) or 
1800 012 828 (country). 

2. Use the original box and packaging to transport your notebook to and from the Acer 
Repair Centre. 

3. If your notebook must be collected you will be advised of the courier pickup details. 
Make a photocopy of the Repair Shipping form (Appendix E on page 36) and fill out the 
details as provided by the Customer Service Centre. Attach this to the outside of the box 
in which the notebook is packed and keep it ready for courier pickup. Please ensure your 
notebook is ready for collection on the date agreed. 

4. If the unit is to be sent to Acer for a repair, make sure that you have a backup of all your 
data. Acer DOES NOT guarantee that the data on your hard disk will be intact after 
repairs. 

 

Make sure that the unit is packed properly and attach a list of contents to it (for 
example, AC Adaptor, extra battery, etc.).  

Make sure it is ready for the courier to pick it up at the agreed time. 

Contact the Customer Service Centre to check the status of your repairs. 
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Using your notebook’s Recovery CDs  

 

IMPORTANT:  

THESE CDs WILL DELETE ALL DATA ON YOUR NOTEBOOK AND WILL 
OVERWRITE ALL SETTINGS THAT YOU HAVE CHANGED.  

DO NOT USE THESE CDs UNLESS YOU HAVE A SEPARATE COPY OF ALL 
THE FILES YOU HAVE CREATED SINCE YOU RECEIVED YOUR 
NOTEBOOK. YOU MAY ALSO WANT TO MAKE A NOTE OF YOUR 
SETTINGS. 

 

When would it be necessary to use the Recovery CDs? 

Only use these CDs if you are having difficulties with your notebook and you have sought 
help within your school or you have contacted the Department’s Customer Service Centre and 
they have advised you to use the Recovery CD. These CDs disk will return your notebook to 
its original configuration, thus fixing any problems caused by software changes since you 
received your notebook.  

The Recovery CDs will NOT reinstall: 

�  Encarta 2003 
�  Windows XP Interactive Training 
�  Office XP (and Publisher XP) Clip Art 
�  Visio 2002 Viewer. 

 

To use the Recovery CDs 

1. Turn your notebook on. 
2. Press F12. 
3. Put Recovery CD - Disk 1 into the CD drive. 
4. Using the arrow keys, select Boot from CD. 
5. Press <Enter>. The Recovery process will start.  
6. Follow any instructions. 
7. Wait until the imaging software has finished (about 10 minutes) then restart your 

notebook and copy your files back onto it. Replace all the settings for internet, clock, 
mouse etc. 

8. Put the Recovery CDs in a safe place. 
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Customer Service Centre  

If you require assistance, please contact the Department’s Customer Service Centre on: 

Metropolitan: 9264 5555 

Country: 1800 012 828 

NOTE: Please retain the original box and packaging. This will be required if you need to 
transport your notebook to and from the Acer Repair Centre. 
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Appendix A: Changing the Mouse settings 

Changing the Mouse speed. 

1. Tap Start > Control Panel.  
2. Double-tap Mouse. 
3. Tap on the Pointer  Options tab. 
4. Change the pointer speed to a 

speed that suits you. 
5. You can also choose to have a trail 

display behind the pointer to make 
it easier to see. Experiment with 
this. If you lose the pointer, press 
<Ctr l> to highlight it. 

6. Tap Apply to test the mouse 
movement. A single movement on 
the touchpad should move the 
mouse right across the notebook 
screen. 

 

 

Changing the type of pointer 

1. Tap on the Pointers tab.  
2. In the Scheme section, choose a 

different pointer type (for 
example, Windows Black).  

3. Tap Apply to see the new pointer. 
You may find this pointer easier to 
locate than the regular one. 

4. Make any other adjustments to suit 
your way of working. 

5. Tap OK.  
6. Close the Control Panel. 
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Appendix B: Frequently Asked Questions 

Why is my 56K modem not connecting at 56K speeds?  

Several factors can affect connection speed, such as line noise, number of people 
connecting/connected to your ISP, and the age and condition of the telephone lines. A 56K 
modem does not guarantee all connections at 56K; rather it offers the ability to connect at up 
to 56K.  

Why is my CPU speed slower on battery? 

The SpeedStep technology that is resident on these notebooks adjusts the CPU speed 
depending on the power source. SpeedStep will slow the CPU speed down to reduce battery 
consumption allowing for longer battery life. Once an AC adaptor is connected to the 
notebook, SpeedStep returns the CPU speed to normal.  

Why am I getting no sound? 

The volume on the notebook is controlled by holding down the Function <Fn> key and 
pressing the up and down arrow keys. The volume level is shown on the screen. 

Why do I get intermittent CD Read Errors? 

When a CD ROM drive intermittently reads a CD, it's normally caused by a dirty or scratched 
CD, or a problem with the CD drive.  

Try reading different CDs to see if all or just one CD has trouble being read. If it's only a 
particular CD, that CD is most likely scratched or dirty. CD cleaning kits are available at most 
places that sell CDs. If all CDs have trouble being read, there may be a problem with your CD 
drive.  

Why is my system running slow? 

If you have noticed your system running slower than usual it may be due to a fragmented hard 
disk drive. (Note: Other factors such as RAM memory, cache memory, and free space on your 
hard drive may also affect system performance.) Your hard drive does a lot of reading and 
writing and, over an extended period of time, it can become fragmented – this simply means 
that the files on your hard drive are not in continuous order, so the hard drive takes longer to 
load files or programs. 

To put your files back in order you use a program call Disk Defragmenter. This program will 
optimise your hard disk drive by placing the files on your drive back in continuous order, and 
will increase your notebook's performance.  

1. Tap Star t > All Programs > Accessor ies > System Tools > Disk Defragmenter . 
2. Select the drive to be 'de-fragged'. 
3. Tap Analyze. Windows will indicate if this drive should be defragmented.  
4. If you need to defrag, tap Defragment to start the process. 
5. The time required to completed the defragmentation of the hard disk drive will depend 

on its size.  
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Appendix C: Keyboard shortcuts in Windows XP 

Windows Key �  Fn (Function) Key 

�  Opens the Start menu <Fn> + F1 Opens a windows showing the 
functions of the keys 

�  + M, or  

�  + D 

Minimises all windows <Fn> +F3 Puts the notebook into 'standby' – a 
power saving mode if you are 
called away. Touch any key to 
wake the notebook up again 

<Shift> + �  + M Restores all minimised 
windows to their previous 
size 

<Fn> +F4 Puts the notebook into 'hibernation'. 
It must be restarted to resume; you 
will have to re-enter your 
password.  

�  + <Tab> Cycles through the taskbar 
icons 

<Fn> +F5 Selects the screen(s) you want to 
use when using an external display 
device (e.g. projection unit, 
external monitor). Keep pressing 
<Fn> +F5 until the arrangement is 
the one you want. 

�  + F Opens the Search window <Fn> +F6 Saves power by turning the screen 
off – tap any key to resume. 

�  + E Opens My Computer  <Fn> +F7 Turns the touchpad on or off. Use 
this if you are using an external 
mouse or if you accidentally touch 
the touchpad while typing and your 
work scrolls. <Fn> +F7 turns the 
touchpad on again. 

�  + R Opens the Run dialog box <Fn> + F8 Turns the speaker on or off. <Fn> 
+ F8 turns it on again. 

�  + F1 Opens the Help and 
Support Center window 

<Fn> + the 
r ight and 
left ar row 
keys 

Changes the brightness of the 
screen slightly.  

�  + <Break> Displays the Systems 
Properties dialog box 

<Fn> + 
F11 

Turns the numeric pad on. <Fn> + 
F11 turns it off again. 
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Appendix D: Occupational Health and Safety 

 

This document has been developed to inform Department staff of the potential safety 
and health hazards associated with the use of notebook computers and suggested 
strategies to reduce the risk of injury. 

Notebooks offer a choice of environments and locations where a person can use them. 
However the design of notebooks does not allow you to make some basic ergonomic 
adjustments.  

The risk of physical strain injuries to the neck, shoulders, and arms, and eye strain is generally 
higher with notebooks than it is with desktop computers. This is due to the inability to separate 
the keyboard and the screen and the variety of environments in which a notebook is used.  

Potential hazards with notebook use 

The main feature of notebooks that causes problems is the lack of ergonomic adjustment – this 
promotes poor posture. If the screen is at the optimal height for the operator then the keyboard 
is too high, and if the keyboard is at the optimal height then the screen is too low. Both 
scenarios may contribute to muscle discomfort or strain to varying degrees.  

Potential injuries that can occur through using notebooks include: 

�  Occupational Overuse Syndrome (OOS) [also known as repetitive strain injury (RSI)] 
as a result of sustained unnatural postures and/or prolonged tension on muscles, 
tendons, and other soft tissues. 

�  Eye strain through use in environments where there is poor lighting, glare, or 
reflection, and as a result of straining to view details on small screens.  

�  Manual handling strain through carrying notebooks for extended periods and/or lifting 
them out of awkward spaces. Strain may be the aggravation of an existing injury. 

Tripping hazards can also exist where the notebook has external cables attached such as mains 
power cords or telephone lines. 

Minimising the risk of strain or injury 

It is not possible to adopt a good posture 
when working with a notebook without 
additional equipment. However there are a 
number of ways that the risks can be 
minimised.  

If a laptop is to be used for extended periods 
(more than 2 hours in any one session) an 
external monitor and/or keyboard and mouse 
should be used. Ideally the notebook should 
be attached to a docking station. This allows 
the monitor to be adjusted to the correct 
height for the operator.  

 

External keyboard, mouse and monitor, 
with notebook in a docking station 
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As it is not possible to adopt the correct neck 
and wrist postures without the use of an 
external keyboard and mouse, it is preferable 
(in most cases) to set the keyboard at the 
correct height rather than the screen. 
Although this places more strain on the neck 
muscles, this is generally more preferable as 
they are larger and stronger muscles and more 
able to cope with the increased workload. 
This can be achieved by placing the notebook 
on a desk at a height where the elbows are at 
90 degrees and the wrists kept straight. 

  

Prefer red notebook position  

There are also a number of other ways to reduce the risk of strain or injury. These include: 

�  Adopting the best possible posture. Whenever possible sit in a comfortable chair at a 
desk. 

�  Taking frequent rest breaks (at least every 20 minutes but more often if the setup is not 
optimal) to allow eyes and muscles to recuperate. 

�  Not using for extended periods (maximum of 2 hours in any session). 
�  Using an external mouse, keyboard, and monitor where possible. 
�  Setting the screen at an angle that reduces, as far as possible, the need to bend your 

neck and minimises reflections. 
�  Considering using a trolley or backpack to carry the notebook. 

Preventing eye strain 

Eye strain and headaches can be caused by the constant viewing of small objects on a small 
screen, incorrect monitor position, or glare or reflections from lighting sources. The risk of eye 
strain can be reduced by ensuring that you: 

�  Work in environments free from glare or reflection. 
�  Have adequate lighting. 
�  Increase font size for comfortable viewing. 
�  Use a standard computer monitor at a docking station where possible. 
�  Position the monitor for comfortable viewing distance. 
�  Take frequent rest breaks. (An old but valid idea is the 20/20 rule which states "every 

20 minutes look at something 20 feet away (approx 6 metres) for 20 seconds"). 
�  Regularly blink to lubricate your eyes.  

Preventing manual handling injuries 

Notebooks are often carried in addition to all the usual personal belongings. They are also 
lifted in and out of cars or other awkward spaces thus increasing the risk of a muscular strain 
injury. Manual handling risks can be reduced through: 

�  Planning your day so you can minimise the need to carry the notebook. 
�  Minimising the load you are carrying (make two trips to carry your belongings). 
�  Alternating sides of the body that you are placing the load on. 
�  Using a trolley or backpack. 
�  Using lifting techniques that minimise strain to the spine (maintain the natural curves 

in your spine by bending your knees and keep the load close to your body). 
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Preventing tripping hazards 

To minimise the risk of tripping, only use the cords that you need for that session and do not 
place them across walking areas. Consider the use of extension cords when making 
PowerPoint presentations. 

Ongoing discomfort or pain 

If you are experiencing ongoing discomfort or pain that is not eliminated by the strategies 
suggested in this document, seek medical advice and discuss the problem with your Principal.  

Further advice on reducing muscular strain is also available from Employee Support Services 
in Central Office on 9264 4889. 

Ergonomic and posture principles for general computer use 

�  Sit up and back in your chair. 
�  The top of the monitor screen should be at or just below 

eye level. 
�  The monitor should be positioned directly in front. 
�  At the correct height for keyboarding your elbows are 

approximately level with the keyboard and bent at 90-
100 degrees. 

�  The knees should be at 90 degrees or greater. A 
footstool may be required.  

�  Keep elbows close to your sides. 
�  Working documents should be between you and the monitor or just to the side of the 

monitor on a document holder.  
�  Frequently used equipment should be within easy reaching distance. 
�  Keep the mouse as close to the keypad as possible and on the same level. 
�  Look away from the screen and focus on distant objects regularly to reduce eye strain 

(remember that blinking helps to lubricate your eyes). 
�  Avoid glare or reflection from windows or lights where possible. 
�  Avoid holding your muscles tensed for long periods of time. Stretch and change 

postures frequently. 
�  Change tasks frequently to help prevent muscle stiffness.  
�  Take short frequent micro-breaks. Short and frequent breaks are more beneficial than 

longer less frequent breaks. Suggested breaks are 2-3 minutes every 15-20 minutes, 5 
minutes every 30 minutes, or 10 minutes every hour.  
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Useful links 

There are many web sites that provide useful information on ergonomics and computers at 
home and in schools. A few of these sites are listed below. The Department does not 
necessarily support information provided on these web sites.  

�  http://healthycomputing.com/ 
�  http://ergo.human.cornell.edu/ 
�  http://www.office-ergo.com/ 
�  http://www.ergonomics.com.au/howtosit.htm 
�  http://www.pc.ibm.com/ww/healthycomputing/ 
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Appendix E: Repair Shipping Form 

 

 

 

 

To:   Acer  Repair  Centre  
  Acer  Computer  Australia 

Level 3, 30 Hasler  Road 
Herdsman Business Park 
Osborne Park WA 6017 

 
 
National Call Centre Case Number : ____________________ 
(To be filled in by you; supplied by Department’ s Customer Service Centre from Acer) 
 
Ser ial Number : _____________________ 
(Aust. Serial No. on the base of your notebook) 

 
Name: ___________________________________________ 
 
Return Address:  
_____________________________________ 
_____________________________________ 
_____________________________________ 
_____________________________________ 
 

 

 

 


